PROCEDURE AND PUBLISHING STANDARDS

PRESENTATION

Casa de Velázquez's publications cover research in human and social sciences, not limited to any particular period, in a broad range of geographical areas (Iberian Peninsula, the Atlantic region and the Maghreb) and specialities (archaeology, history, literature, geography, sociology, anthropology, linguistics…).

According to the Editorial procedure, works proposed for publication undergo a preliminary evaluation, by the Editorial board in the case of collections, or by the Editorial panel in the case of the journal.

Pre-print proposals that have not been published or submitted to other publishers are assessed for relevance, originality, scientific rigour, contribution to knowledge, scientific weight, technical feasibility and quality of methodology and writing.

Once the pre-print proposal is accepted, the complete dossier is submitted to a double-blind peer review. After the reviewers’ recommendations have been addressed by the author/scientific editor, the definitive manuscript is entered in the schedule of publications. A publishing agreement or a letter assigning copyright is then signed between Casa de Velázquez and the author/scientific editor.

The order of processing of definitive manuscripts, duly reviewed and conforming to the editorial standards, is determined by the date of reception following agreement in principle for production.

The head of the Publications service is the liaison with the author or scientific editor(s). Once the definitive manuscript is in process, the author/scientific editor will liaise with the publishing secretariat.
THE COLLECTIONS AND THE JOURNAL

**BIBLIOTHÈQUE DE LA CASA DE VELÁZQUEZ (BCV)**

BCV is the institution’s flagship collection. It consists of monographs, most of them reworkings of PhD theses by former scientific members, although this is no longer a requirement for publication in the collection.

*Technical specifications*

The languages of publication are French or Spanish.

- No cover illustrations
- Formats: 17 x 24 cm or 21 x 29.7 cm
- Maximum number of keystrokes: 1 000 000 (including front matter, text, footnotes, endnotes and spaces).
- Summary of references at end of work (sources and critical apparatus)
- Summary of the work, presented at the end in French, Spanish and English
- Illustrations: black and white for paper format; colour for numeric format).

*Author’s responsibility*

- The manuscript delivered (text, illustrations and a summary of 6 000 keystrokes) must conform to the collection’s formal and scientific requirements
- Observance of the Advice to authors (text and illustrations)
- Preparation of data for compilation of index (where applicable)

☐ Complete the on-line form for submission of a BCV publishing proposal.

**COLLECTION DE LA CASA DE VELÁZQUEZ (CCV)**

CCV is intended for the publication of collective works compiled from meetings organised as part of the Casa de Velázquez Programme of scientific activities (conferences, congresses, study sessions).

Texts are reworkings of the proceedings of a meeting. They should not exactly reproduce communications. Some coordination and collation of the different contributions is therefore required to meet the collection’s standards.

*Technical specifications*

The languages of publication are chiefly French and Spanish; English, Catalan, Italian and Portuguese are accepted provided that they are the author’s native language.

- Cover with colour illustrations
- Formats: 17 x 24 cm or 21 x 29.7 cm
- Maximum number of keystrokes: 1 100 000 (including front matter, text, footnotes, endnotes and spaces).
  - up to 20 contributions: Maximum 55 000 keystrokes per article
  - from 21 to 25 contributions: Maximum 44 000 keystrokes per article
Summary of references at end of work (sources and critical apparatus)
Illustrations: Maximum 5 per contribution (black and white for paper format; colour for numeric format)

Responsibility of scientific editor(s) (maximum 3)
Only Casa de Velázquez correspondents. Responsible for the following tasks:
• To collect contributions to the work and coordinate the different authors
• To forward the Letter of assignment of copyright to contributors, to be returned completed and signed
• Harmonisation of texts, compilation of a single references section at the end of the work, and where applicable preparation of data for an index
• Observance of the Advice to authors (text and illustrations)
• Proposal of a cover image
• The manuscript delivered (text and illustrations) must conform to the collection’s formal and scientific requirements.

Responsibilities of authors of contributions
• Adherence to the collection’s specific characteristics, both formal and scientific
• Observance of the Advice to authors (text and illustrations)

☐ Complete the on-line form for submission of a CCV publishing proposal.

ESSAIS DE LA CASA DE VELÁZQUEZ (ECV)

Collection of brief works of synthesis. The object is to publish works by reputed authors aimed at a wider readership.

Technical specifications
The languages of publication are French or Spanish.
• No cover illustrations
• Format: 14 x 22 cm
• Maximum number of keystrokes: 400 000 (including front matter, text, footnotes, endnotes and spaces)
• Notes limited to one per page, to be presented per chapter at the end of the volume, containing literature references
• No summary of references at end
• Illustrations: Maximum 5 (black and white for paper format; colour for numeric format)

Author’s responsibility
• Adherence to the collection’s specific characteristics, both formal and scientific
• Observance of the Advice to authors (text and illustrations)

☐ Complete the on-line form for submission of a ECV publishing proposal.

MÉLANGES DE LA CASA DE VELÁZQUEZ. NOUVELLE SÉRIE (MCV)

MCV is a half-yearly journal of human and social sciences and literature, consisting of a thematic Dossier and a Miscellanées section. A section Actualité de la recherche is published online when the issue comes out, offering articles of historical research, opinions on current
scientific debates, cross-readings and reviews of recently-published work. These last are published online only (mcv.revues.org).

**Online access**

The old collection (years 1965-1996) is freely accessible at persee.fr.
The New Series (2003-) is available at mcv.revues.org.

**Technical specifications**

The languages of publication are chiefly French and Spanish; English, Catalan, Italian and Portuguese are accepted provided that they are the author's native language.

- No cover illustrations
- Paper format: 17 x 24 cm
- ISSN 0076-230X
- Electronic ISSN 2173-1306

**Dossier**

**Technical specifications**

- Composition: one presentation (6 000 to 18 000 keystrokes, without footnotes or references), five to seven contributions and one conclusion or one counterpoint article (55 000 keystrokes per contribution, including footnotes and references)
- Text presenting the Dossier, to be rendered in French, Spanish and/or English (800 keystrokes)
- Summaries of the contributions, in order of their appearance in the Dossier, to be rendered in French, Spanish and/or English (800 to 1 000 keystrokes per summary)
- Key words: 6 (in French, Spanish and/or English, placed in alphabetical order)
- Illustrations: Maximum 10 per contribution (black and white for paper format; colour for numeric format)

**Responsibility of scientific editor(s) (maximum 2)**

Only editorial correspondents. Responsible for the following tasks:

- To collect the contributions and coordinate with the various authors in the dossier, and to harmonise and revise texts and summaries
- To forward the Letter of assignment of copyright to contributors, to be returned completed and signed
- Observance of the Advice to authors (text and illustrations)
- The manuscript delivered (text, illustrations and a summary of 800 keystrokes) must conform to the journal's formal and scientific requirements

**Responsibilities of authors of contributions**

- Adherence to the journal's specific characteristics, both formal and scientific
- Observance of the Advice to authors (text and illustrations)

☐ Complete the on-line form for submission of a MCV publishing proposal (Dossier).

**Miscellanées**

**Technical specifications**

- 55 000 keystrokes (per contribution, including footnotes and references)
- Key words: 6 (in French, Spanish and/or English, placed in alphabetical order)
- Summary of article, to be rendered in French, Spanish and/or English (800 to 1 000 keystrokes)
- Illustrations: Maximum 10 (black and white for paper format; colour for numeric format)
Responsibilities of authors of articles

- Adherence to the journal's specific characteristics, both formal and scientific
- Observance of the Advice to authors (text and illustrations)

☐ Complete the on-line form for submission of a Article in Miscellanées.

Débats

Technical specifications

- Introduction: 8 000 to 10 000 keystrokes
- Contributions: 100 000 keystrokes in total (for example, up to six contributions: maximum 15 000 keystrokes per article, including footnotes)
- References are rendered in full in footnotes (see Instructions for remittal of references)
- Text presenting dossier, to be rendered in French, Spanish and/or English (800 keystrokes)
- Illustrations: maximum 5 per contribution (colour for numeric format). Media (videos, audio documents) may be published online

Responsibility of scientific editor(s) (maximum 2)

Only editorial correspondents. Responsible for the following tasks:

- To collect the contributions and coordinate with the various authors in the dossier, and to harmonise and revise texts
- To forward the Letter of assignment of copyright to contributors, to be returned completed and signed
- Observance of the Advice to authors (text and illustrations)
- The manuscript delivered (text, illustrations and a summary of 800 keystrokes) must conform to the journal's formal and scientific requirements

Responsibilities of authors of contributions

- Adherence to the journal's specific characteristics, both formal and scientific
- Observance of the Advice to authors (text and illustrations)

Critical reviews

Technical specifications

- Cross-readings (12 000 – 15 000 keystrokes)
- Reviews (5 000 – 7 000 keystrokes)
EDITORIAL PROCEDURE

It is understood that when any step is taken to publish the results of a scientific research project, the manuscript (book or article) has never been published and has not been submitted for publication elsewhere. The sending of a text is taken to imply acceptance and observance of the Copyright and self-archiving policy operated by Casa de Velázquez.

SUBMITTING A PROPOSAL

All pre-print proposals are submitted to a preliminary assessment by either the Editorial board or the Editorial panel depending on where they are intended to be published (BCV, CCV, ECV or MCV).

The author/editor will be advised of this assessment; if it is favourable, this means that the manuscript must be forwarded within a maximum of one year. If that deadline is exceeded, the proposal will have to be resubmitted.

Please complete the on-line form for submission of a publication to Casa de Velázquez editions:

- Proposal for BCV
- Proposal for ECV
- Proposal for CCV
- Proposal for MCV
  (Dossier ou Article in Miscellanées)

SUBMITTING A COMPLETE DOSSIER FOR SCIENTIFIC PEER REVIEW

Presentation of dossier

The manuscript must be submitted in the format of the target collection.

Only complete dossiers may be submitted for expert review.

To be considered complete, a dossier must contain the points listed below, following the nomenclature given (no spaces, no accents).

- Dossier textes
  00a_Title_page
  00b_Contents (CCV, ECV et MCV)
  00c_Preliminaries (Preface, Presentation…)
  01_Introduction
  02_AuthorX (CCV, MCV) or ChapI (BCV, ECV)
  03_AuthorY (CCV, MCV) or ChapII (BCV, ECV)
  04_AuthorZ (CCV, MCV) or ChapIII (BCV, ECV)
  …/…
  09_Conclusion
  10_References
  11_annexe(s)
  12_Summary (BCV and MCV)
  13_Index (BCV and, where applicable, CCV)
  14_Table_of_contents (BCV)
  15_List_of_annexes (BCV)
  16_Legends
Illustration dossier

Illustrations must be referenced individually according to type (figure, chart, photograph, plate), with consecutive numbering for a monograph (BCV, ECV) or per article for a collection (CCV, MCV), accompanied by a list of legends.

Sending the dossier

The author/scientific editor should forward the complete dossier in the following formats:

- Word, automatic page-numbering. The name of the author/scientific editor, the institution to which he/she belongs and full address are to be placed in a separate file for attachment to the email (richard.figuier[a]casadevelazquez.org for collections or melanges[a]casadevelazquez.org for the journal);
- paper, two anonymous copies, preferably printed on both sides, addressed to: Head of Publications or Editorial Secretary of MCV - Casa de Velázquez - Ciudad Universitaria - Calle de Paul Guinard, 3 - 28040 Madrid.

Peer review

This is carried out by specialists selected by the Editorial Board, on the basis of their field of research (period and subject) and their status. Author anonymity is assured.

Upon receipt of the reviews, which is within five weeks, a summary is forwarded to the author/scientific editor. If the report is favourable, he/she is invited to send in the Definitive manuscript for publication. Where appropriate, this will incorporate the amendments proposed by the experts. In case of disagreement, he/she will be asked to substantiate his/her position.

If there is discrepancy between the reviews, a third expert is called on. If the reviews are unfavourable, the manuscript cannot be published and the author/scientific editor will be so advised.

Sending in the definitive manuscript for publication

The author/scientific editor should address the definitive manuscript to the Head of Publications in the case of one of the collections (BCV, CCV, ECV), or to the Editorial Secretary in the case of the journal (MCV), at which point it enters the publishing schedule.

If the publishing standards are not strictly adhered to, the manuscript (book or contribution) will be returned to the author/scientific editor for rectification (see Advice to authors).

For the rest, only illustrations adhering to the Instructions for remittal of illustrations will be preserved. Along with the definitive manuscript, the author/scientific editor must furnish a draft text for the fourth cover page (maximum 800 characters).
If all the elements are not delivered within one year of notice of acceptance of the manuscript, the latter will be submitted to a fresh expert review.

Download the form for confirmation of remittal of the elements of your definitive manuscript for a publication to Casa de Velázquez publications:

☐ Memo definitive manuscript BCV  ☐ Memo definitive manuscript ECV
☐ Memo definitive manuscript CCV  ☐ Memo definitive manuscript MCV

EDITING OF THE MANUSCRIPT

Once the manuscript is included in the publishing schedule, it is processed in three stages:

Stage 1. – Preparation of copy (revision and corrections)

• A first set of proofs (EP1) is sent to the author/scientific editor once the manuscript has been revised by the editorial secretary.
• The author/scientific editor is asked to make corrections clear and readable to avoid the need for further review. Rather than marginal notes, it is recommended to use typographic correction signs, which can be downloaded here.
• All author’s corrections (additions, deletions or amendments), of text and illustrations, are to be avoided and may only be made at this stage. These precautions are intended to avoid delays and extra production costs.
• The author/scientific editor is required to adhere to the deadline for remittal of corrections of EP1s (2 weeks for a contribution, 5 weeks for a book).
• The author/scientific editor is recommended to keep a copy of the corrected version.

Stage 2. – Composition

• A second set of proofs (EP2) is sent to the author/scientific editor.
• The author/scientific editor is required to check the corrections to EP1s and ensure that the illustrations are properly in place.
• The only authors’ corrections allowed are additional recent references and syntactical errors or misprints. Any amendment, however minor, could displace text over several lines, requiring the reformatting of whole paragraphs and re-setting of several pages or even the entire manuscript. This can affect page numbering, tables of contents and other internal references.
• Where necessary the author/scientific editor must add or adjust the index of proper names. It is only at this stage that the page-numbering of the manuscript is final.

Stage 3. – Ready to Print (RTP)

• The author/scientific editor must okay the final proofs for forwarding to the printers, within one week of returning the form duly completed and signed.
• Only corrections of internal page references, misprints, hyphenation errors or discrepancies between running heads and the abstract (CCV, ECV, Dossier MCV) or
the table of contents (BCV) will be accepted. No addition, deletion or amendment is allowed at this stage, either in text or illustrations.

Download the RTP form to complete and sign for your printable voucher.

**PUBLISHING AGREEMENT, LETTER OF ASSIGNMENT OF RIGHTS AND COMPLIMENTARY COPIES**

A publishing agreement is signed between the director of Casa de Velázquez and the author/scientific editor once the form and content of the manuscript have been approved.

In the case of a publication in the CCV or the journal, a letter agreeing to the assignment of copyright is signed by the author of each contribution.

The press service and complimentary copies are provided from the stocks of Casa de Velázquez. For these purposes the author/scientific editor should send the Head of Publications the names of up to ten periodicals from which he/she considers that a review can properly be requested.

Also, a list of names should be drawn up in conjunction with Casa de Velázquez, for up to ten complimentary copies.

The number of copies to be reserved will be specified in the agreement. By way of example:

- 5 free copies per scientific editor of a collective work (CCV), then a 30% discount on the purchase of further copies;
- 10 copies per author of a monograph (BCV, CCV), then a 30% discount on the purchase of further copies;
- 1 copy per contributor to a collective work (CCV) or the journal (MCV, including scientific editor[s]), then a 30% discount on the purchase of further copies;
- Each contributor will receive an offprint of his/her article or chapter in PDF format.

For any further information, contact us.
INSTRUCTIONS TO AUTHORS

INSTRUCTIONS ON COMPOSITION

General

The number of keystrokes indicated for each collection (BCV, CCV, ECV or MCV) includes spaces.

Authors/scientific editors are asked to proceed as follows:

- choose a simple text layout, with a clear hierarchy of sub-titles, avoiding generic terms in Introduction and Conclusion;
- acknowledgements for articles (CCV, MCV) should be included in a footnote; acknowledgements for other works (BCV, CCV, ECV) should be provided in a separate file;
- manuscript page-numbering should be continuous; use the automatic numbering tool;
- do not use typesetting effects (page breaks, multiple spaces, automatic formatting, carriage returns for inter-paragraph spacing, etc.);
- deactivate “Track changes” macros.

Font policies

Manuscripts in Latin type must use Times New Roman or some other Unicode font policy that allows transliteration of terms in non-Western languages.

Avoid boldface and underlining.

For Greek, download IFAO-Grec Unicode from the Institut français d’archéologie orientale – El Cairo website.

For transliteration of Arabic or transcription of specific characters into certain Western languages, download JaghbUni (Mac or PC).

Notes and reference marks

Notes are to be consigned to the foot of the page (BCV, CCV, MCV) or per chapter at the end of the volume (ECV).

Reference marks are to be inserted only with the Word [Insert] > [Note] > [footnote] tool for BCV, CCV and MCV or [endnote] for ECV, with continuous "Automatic" numbering.

These reference marks are to be placed after punctuation marks and inside the closing bracket in the case of a direct reference to the citation, never inside a title or sub-title. Do not reference one note to another.

Literature references are to be cited according to the Instructions for remittal of literature references. Any arguments or comments must be written clearly and concisely.
Figures and figure references

Authors/scientific editors are asked to follow the Instructions for remittal of illustrations.

Figures are never to be inserted in the text; the relevant figure reference should be placed exactly as the logic of the discourse dictates and bracketed (fig. 1, p. 00), never in a sub-title or footnote.

Citations

All citations must be referenced in a note citing the source, the name of the translator where applicable, and the page or folio number.

Where these exceed three lines, the quotation marks should be removed and the quotation detached from the text by a paragraph break before and after.

Citations in languages other than that of the manuscript must be translated (or explained) within the body of the text. The original text should be reproduced in a note, in italics between quotation marks, followed by the abridged literature reference and the name of the translator in parentheses, as in the following examples:

« Dios quiso, en un principio que el hombre fuera hecho de dos partes: estando la una compuesta de una masa bastante pesada y densa […] que pudiera estar realmente vista y tocada, esto es, hecha de tierra. […] En el habla común y corriente llamamos a ésta cuerpo » (ARIAS MONTANO, 1999, p. 129, French trans. by author of this book/article).

« He [i.e. Ḥudhaifa] had taken this system of intercalation from the Jews nearly 200 years before Islām; the Jews, however, intercalated 9 months in 24 lunar years. In consequence their months were fixed, and came always in at their proper times, wandering in a uniform course through the year without retrograding and without advancing » (AL-BĪRŪNĪ, Kitāb al-ā ār al-b qiyā , ed. and trans. by SACHAU, 1998, Arabic text p. 12; English trans., p. 14).

Foreign languages

Words (Latin characters) in a language other than the one the manuscript is written in are to be placed in italics, without quotation marks, followed by a translation, between quotation marks and bracketed, the first time they occur.

File references must be left in the original background language. Names of ministries, institutions, learned societies or official bodies should likewise be left untranslated.

All Latin words or phrases that appear in dictionaries are to be rendered in Roman type (e.g. in situ, passim, de facto, a priori, etc.).

And again, the usual spelling of certain Arabic words sanctioned by usage, such as oued, souk, fondouk, mufti, vizir, etc., should be preserved.

Authors are asked to transcribe all other Arabic terms according to the principles followed in standard works of research dissemination.
Download recommendations and table for Transliteration of Arabic.

Tables

Tables should be located within the text, preceded by their respective titles. They are to be created only using the [Table] > [Insert] tool in Word.

Avoid tables of less than 5 lines, whose content can be consigned in the text.

Indicate the source used to compile the table at the foot of each one.

To insert notes, use a different numbering style from the text. Use letters a, b, c… italicised in superscript.

Typographic conventions and rules

For currently applicable rules in English, see New Hart’s Rules, 2nd ed. OUP, Oxford 2014 and www.gsbe.co.uk.

A) UPPER/LOWER CASE

For small capitals (chapter and century numbers, authors’ surnames in notes and References) do not use a smaller font, but only the appropriate tool supplied by Word ([Format] > [Font] > [Small Caps]).

B) SPACING

Do not insert multiple spaces between words to align or to achieve any other kind of effect, including after italics.

The signs %, €, units of time, etc. should be preceded by a hard space. Groups of three digits in numbers containing thousands should likewise be separated by a hard space.

C) QUOTATION MARKS

For primary marks, use double inverted commas, “...”, without spaces.

For secondary marks, inside primary marks, use single inverted commas, ‘...’, without spaces.

D) SQUARE BRACKETS

These substitute for round brackets: if already within parentheses ([...]); following parentheses (...) [...] ; or inside a quotation to indicate an elision or addition [...] .

E) PUNCTUATION AND DOUBLE PUNCTUATION MARKS

There is no space between commas or full stops and the preceding word.

In any language other than French, there is no space between a punctuation mark and the word preceding it (e.g.: Árabes, judías y cristianas: mujeres en la Europa medieval).

Abbreviations and symbols

If there are more than 10 abbreviations and acronyms, please provide a list.
A) Common abbreviations

- b.: ibn/bint (son/daughter of)
- c.: century (e.g. 17th c.)
- ca (no full stop): circa
- ch.: chapter (followed by Roman numerals in small capitals)
- cm (no full stop): centimetre
- coord.: coordinator(s)
- dir.: director(s)
- ed., eds: editor(s)
- et sq., et sqq.: following page(s)
- fig.: figure
- f., ff.: folio(s)
- ibid., Id., EAD.: the same
- l.: line
- ms., mss: manuscript(s)
- m (no full stop): metre(s)
- n.: note
- n.d.: no date of publication
- No., Nos.: number(s)
- n.p.: no place of publication
- n.p.: no publisher
- p., pp.: page(s)
- §: paragraph
- %: percentage
- r: recto (preceded by number, w/o space)
- s.v.: sub voce (under the word) [to cite a definition in a dictionary or encyclopaedia, followed by a word in quotation marks: s.v. “Antiocheis”]
- t.: tome (volume) [followed by capitalised Roman numerals]
- v: verso (preceded by number, no space)
- vol.: volume (followed by Arabic numerals)

B) Abbreviations of first names

French first names beginning with a consonant should be abridged up to the first vowel, regardless of the language of the manuscript (Florence: Fl.; Jean-Claude: J.-Cl.; Christophe: Chr.)

C) Chronological information

Use “BCE” and “CE” or “BC” and “AD”.

Islamic dates should be mentioned where the Arabic sources cite them; their Gregorian calendar equivalents should be given after a forward slash, as follows: 463/1071-541/1147 or 463-541/1071-1147, mutually exclusively within the same book, article or Dossier. The Islamic date is not to be given in the case of Christian dynasties, contemporary references or references from Christian sources, European historical events or events occurring in Europe.

Century numbers should be given in Arabic ordinal numbers: 3rd c. BCE.

Millennium numbers should be given in Arabic ordinals: 4th Millennium BP.

Dynasty numbers should be given either by a following Roman numeral, e.g. “Dynasty IV”, or preceded by an Arabic ordinal, e.g. “4th Dynasty”.

Instructions for remittal of illustrations

Authors/scientific editors are asked to take special care as regards the relevance and quality of illustrations. Documents are further to be numbered and referenced individually and consecutively depending on their nature (chart, figure, graph, plate).

Casa de Velázquez, a not-for-profit teaching and research institution, is concerned about compliance with intellectual property laws. Authors and scientific editors are therefore
asked to furnish original permissions for reproduction of illustrations used in commercially-
available works pursuant to the Intellectual Property Code, law no 95-4 of 3 January. To
ensure compliance with this law, each document for reproduction must carry an original
individual permission issued by the rights-holder (person or organisation). The caption
should make due mention of its provenance and copyright.

It is up to the author/scientific editor to verify the legal status of reproductions of
documents to be used to illustrate their research work. If the document is not in the public
domain, he/she must secure the necessary permissions, licences or assignments from the
author of the work or his/her assigns.

Excepting the cover illustration on works to be published in the CCV, it is up to each
author to secure, and if necessary pay for, illustrations and reproduction rights.

In the event of failure to follow these instructions, Casa de Velázquez reserves the right to
refuse illustrations that might encounter objections.

☐ Download the application form for Permission for reproduction in cases where the holder of title in the work, or its
author or assigns, do not have it.

Technical specifications

Authors are asked to work to the scale of the publication, adapting to the dimensions of
the collection concerned.

- Formats accepted: .ai, .eps, .jpeg, .png and .tiff.
- Resolution: Minimum 300 dpi. Images of 72 dpi downloaded from the web are
  therefore not acceptable.
- Dimensions: minimum 5 x 5 cm; maximum 15 x 30 cm.

A ) Graphs:

- Please provide the numeric data.
- Use greyscales for paper format and colour for numeric format.
- Use the Minion Pro font policy for written information (names and/or captions).
- Avoid presenting information in pie chart form.

B ) Maps and Charts:

- Should be created using Adobe Illustrator (.ai) software.
- The scale of the graph should be indicated by insertion of a graded line segment
  (never in the form: 1/100 or 1/1000).
- Indicate North.
- Use greyscales (minimum 15 %; maximum 85-90 %) for paper format and colour
  for numeric format.
- Use the Minion Pro font policy for written information (names and/or captions).
- Line width: minimum 0.15 pt for solid or dotted lines and 0.25 pt for line and
  copy-dot work.
Items to be supplied

- Digital file for each illustration, identified by author’s name (CCV, MCV) or chapter number (BCV, ECV) and the call number matching the one cited in the manuscript, as in the following examples:

  02_AuthorX_fig1 (CCV, MCV) ou 02_ChapI_fig1 (BCV, ECV)

  03_AuthorY_fig1 (CCV, MCV) ou 03_ChapI_fig1 (BCV, ECV)

  ou

  02_AuthorX_fig2 (CCV, MCV) ou 02_ChapI_fig2 (BCV, ECV)

  03_AuthorY_fig2 (CCV, MCV) ou 03_ChapI_fig2 (BCV, ECV)

  ou

  02_AuthorX_fig3 (CCV, MCV) ou 02_ChapI_fig3 (BCV, ECV)

  03_AuthorY_fig3 (CCV, MCV) ou 03_ChapI_fig3 (BCV, ECV)

- Permission to reproduce each illustration for paper and digital formats, numbered in the same way.
- A list of illustrations by author or chapter, in a separate Word file comprising: the nature of each illustration (chart, figure, graph, plate), its number (exactly matching the one in the document supplied), the title and the caption.
- Captions, concise but complete, stating the source and, depending on the type of illustration, citing the available data, as follows:

  Reproduction of works

  **Fig. 1.** – Francisco de Goya, *Portrait de Ferdinand Guillemardet, ca. 1798-1799*, Louvre Museum, Paris. © Musée du Louvre

  Maps and charts

  **Map 1.** – Carte de la peste dans le Doukkala, d’après un croquis du docteur Paul Remlinger (Archives du ministère des Affaires étrangères, séance du Conseil sanitaire de Tanger, 12 octobre 1911)

  Graphs

  **Graph 1.** – Les différents systèmes anthroponymiques (Porto, 14ᵉ siècle)
INSTRUCTIONS FOR REMITTAL OF LITERATURE REFERENCES

References in notes

For BCV, CCV and MCV, bibliographical references are to be abridged in footnotes as in the following model:

- references to sources: SURNAME, Short title in three to five words, page(s);
- references to critical apparatus: SURNAME, year of publication, page(s).

For ECV and articles in the Debates section of MCV, which do not carry a summary bibliography, bibliographical references should be detailed in endnotes in the former case and in footnotes in the latter. They should only be detailed in full on first occurrence (with page number). On second and subsequent occurrences they should be abridged to a maximum of five words.

If the same reference (author, title) is used twice running, the second should be replaced by *ibid.*, indicating the page number if different.

In the case of two consecutive notes referring to the same author, replace the author’s name with *Id.* or *Ead.* on the second and subsequent occurrences.

The abbreviation *et al.* should only be used if the reference contains more than three authors.

References to archives or libraries should be rendered in full on first occurrence, followed by their acronyms in parentheses. Subsequent occurrences should cite only the acronym.

Please do not use latinisms (*art. cit.*, *op. cit.*, *loc. cit.*, *supra, infra...*) and write “see” rather than *vid.* or *cf.*

Bibliographical references

Bibliographical entries should be arranged in alphabetical order and different works by the same author in ascending chronological order (from oldest to most recent). The name should not be replaced by a dash.

If a reference contains several authors, the name of each one should be rendered in full.

If an author has several entries for the same year, they should be distinguished by lowercase letters following the date, without a space (1980a, 1980b, 1980c, etc.).

For modern or contemporary works, cite the year of publication in parentheses after the author’s first name.

For literary or classical works and printed sources, cite the year at the end of the reference, without parentheses. The date of first publication may be specified, in square brackets, after the title.
Literary and classical works by the same author should be arranged in alphabetical order of title, ignoring initial articles.

Index authorless references by the first word in the title, including where this is an article.

Places of publication of works should be cited in the language of the article or work to be published in Casa de Velázquez publications and not in that of the reference of origin. For CCV, the language of the title determines that of the of the collective work.

The bibliography should be confined to references used in the manuscript.

Summary table

<table>
<thead>
<tr>
<th>ABRIDGED REFERENCE IN NOTES</th>
<th>FULL REFERENCE IN BIBLIOGRAPHY</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Books</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Articles</strong></td>
<td></td>
</tr>
<tr>
<td>ABRIDGED REFERENCE IN NOTES</td>
<td>FULL REFERENCE IN BIBLIOGRAPHY</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------</td>
</tr>
</tbody>
</table>

**Theses and other unpublished work**

| RODRÍGUEZ LLOPIS, inédite, p. / pp. | RODRÍGUEZ LLOPIS, Miguel (unpublished), "Los señoríos del reino de Murcia en el siglo XIII", communication presented at Congreso Internacional Conmemorativo del VII Centenario de la Muerte de Alfonso X el Sabio (Toledo, 1984). |
### Catalogues

<table>
<thead>
<tr>
<th><strong>ABRIDGED REFERENCE IN NOTES</strong></th>
<th><strong>FULL REFERENCE IN BIBLIOGRAPHY</strong></th>
</tr>
</thead>
</table>

### B) Sources

<table>
<thead>
<tr>
<th><strong>ABRIDGED REFERENCE IN NOTES</strong></th>
<th><strong>FULL REFERENCE IN BIBLIOGRAPHY</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive documents and manuscripts</td>
<td></td>
</tr>
<tr>
<td>“Práctica de la Chancillería”, f. / ff.</td>
<td>“Práctica de la Chancillería de Granada (s. xvii)”, BNE, ms. 309.</td>
</tr>
<tr>
<td>Printed sources</td>
<td></td>
</tr>
<tr>
<td>ABRIDGED REFERENCE IN NOTES</td>
<td>FULL REFERENCE IN BIBLIOGRAPHY</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td><strong>IG II 128 Michel 583.</strong></td>
<td><strong>IG II 128 Michel 583.</strong></td>
</tr>
</tbody>
</table>

**C) SPECIAL CASES**

Sacred books (Tanakh, Bible, Koran), archive documents and journal articles should only be cited in footnotes, as follows:

<table>
<thead>
<tr>
<th><strong>Greek and Latin sources</strong></th>
<th><strong>Sacred books</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HOMER, Iliad</strong> II 348.</td>
<td>Koran, IV, 131.</td>
</tr>
<tr>
<td><strong>SOPHOCLES, Electra</strong> 4-6.</td>
<td>Ezequiel XXVII, 4-9.</td>
</tr>
</tbody>
</table>

**Archive documents**

Again, an isolated reference to classical Greek or Latin sources, or a manuscript cited only once, where their inclusion in the list of Sources at the end of the work is not warranted, should be cited only in a footnote.
ANNEXES

- Proposal for BCV
- Proposal for CCV
- Proposal for ECV
- Proposal for MCV (Dossier)
- Article in Miscellanées (MCV)
- Transliteration from Arabic
- Authorisation for reproduction
- Memo for remittal of a definitive manuscript BCV
- Memo for remittal of a definitive manuscript CCV
- Memo for remittal of a definitive manuscript ECV
- Memo for remittal of a definitive manuscript MCV (Dossier et article dans les Miscellanées)
- Letters of agreement for assignment of copyright CCV
- Letters of agreement for assignment of copyright MCV (article)
- Letters of agreement for assignment of copyright MCV (compte rendu)
- RTP form